
OSSSC CRE 2025
Combined Recruitment Examination · Preliminary · Question Paper

28 May 2026 · 4:00 PM - 5:30 PM English Version

RI · ICDS Supervisor · VAW · JA · ARI · Amin · SFS  |  Official Answer Key

About this Paper

This is the OSSSC Combined Recruitment Examination (CRE) 2025 Preliminary written test (Advt. IIE-120/2025-3219) for the posts of
Revenue Inspector, ICDS Supervisor, Village Agricultural Worker, Junior Assistant, Assistant Revenue Inspector, Amin & Statistical Field
Surveyor — 28 May 2026, 4:00 PM - 5:30 PM shift, English version, with the correct option marked as per the official answer key.

Exam pattern: 100 questions · 100 marks · 90 minutes. Sections: Mathematics 20, General Studies 20, English 20, Odia 15, Computer
15, Logical Reasoning 10. Marking: +1 correct, −0.25 wrong.

✓ Correct option (highlighted green)

More from QMaths

Check your marks & All-India rank at rank.qmaths.in. Master English vocabulary with the Blackbook app.

Toppers' Choice, Blackbook of English Vocabulary, Now available in App format : DOWNLOAD NOW

https://rank.qmaths.in/
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25


Paper Set 1 · 28 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Varun, Rohan and Hem each invested ₹20,000 in their business.
After 3 months, each of them withdrew ₹10,000. The total profit over
24 months was ₹81,000, with each month's profit being equal. Find
their profit for the first six months.

A.  ₹20,250

B.  ₹18,750

C.  ₹15,500

D.  ₹19,000

✓

Q2 Quant
If 5 pens cost ₹50, what is the cost of 8 pens?

A.  ₹70

B.  ₹75

C.  ₹80

D.  ₹85

✓

Q3 Quant
A shopkeeper sets the marked price of an item at 8% above cost.
Due to heavy demand, he further increases this price by 12%. Later,
to clear stock, he gives a 20% discount on the last price. What is the
net percentage change in the final selling price compared to the
original cost price?

A.  decrease of 1.232%

B.  increase of 1.232%

C.  decrease of 3.232%

D.  increase of 3.232%

✓

Q4 Quant
What is the average of all prime numbers between 35 and 54?

A.  43.2

B.  44

C.  44.2

D.  45

✓

Q5 Quant
A shopkeeper marks a box of chocolates at ₹800. If he offers a
discount so that the final selling price becomes ₹624, what is the
percentage discount offered?

A.  20%

B.  21%

C.  22%

D.  24%

✓

Q6 Quant
Pipe P can fill a reservoir alone in 3 hours. When Pipe P and Pipe Q
are opened together, the reservoir is filled in 1 hour. Determine the
time required for Pipe Q to fill the reservoir alone.

A.  1 hour

B.  1.5 hours

C.  2 hours

D.  2.5 hours

✓

Q7 Quant
The mean of the observations 10, 20, 10, 40, and x is 20. Find the
value of 3x.

A.  30

B.  60

C.  45

D.  75

✓

Q8 Quant
The price of a laptop is ₹40,000. It undergoes a series of successive
changes: first, a 20% increase; then, a 15% decrease; and finally, a
10% increase. What is the overall percentage change in the price?

A.  12.2% increase

B.  13.6% decrease

C.  13.2% increase

D.  14.7% decrease
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✓

Q9 Quant
Three friends P, Q and R started a business by investing a sum of
money in the ratio of 4 : 3 : 5. After 6 months Q withdraws half of his
capital. If the sum invested by P is ₹29,000, out of a total annual
profit of ₹81,000 find the share of Q in profit.

A.  ₹16,200

B.  ₹17,535

C.  ₹17,110

D.  ₹15,285

✓

Q10 Quant
If ₹27,800 is invested at 5% per year for 2 years, what is the
difference between the compound interest (compounded annually)
and the simple interest?

A.  ₹69.50

B.  ₹61.50

C.  ₹74.50

D.  ₹68.50

✓

Q11 Quant
AB is parallel to CD. A transversal PQ intersects AB and CD at E and F,
respectively, and ∠PEB = 41°. G is a point between AB and CD such
that ∠BEG = 23° and ∠GFE = 26°. What is the measure of ∠EGF?

A.  38°

B.  42°

C.  33°

D.  30°

✓

Q12 Quant
A can lay railway track between two given stations in 6 days, and B
can do the same job in 24 days. With the help of C, they complete
the job in 3 days only. In how many days can C alone complete the
work?

A.  8

B.  9

C.  10

D.  11

✓

Q13 Quant
A car moving at the speed of 56 km/h covers a distance in 9 hours
15 minutes. If it travels the same distance at the speed of 74 km/h,
how long will it take to cover the distance?

A.  4 hours

B.  8 hours

C.  6 hours

D.  7 hours
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✓

Q14 Quant
A balloon is tied to the ground with a string. The length of the string is 80 m and it makes an angle of 60° with the level ground. How high is the
balloon from the ground?

A.  

B.  

C.  

D.  

✓

Q15 Quant
Find the value of the following expression.

A.  19

B.  22

C.  18

D.  9

✓

Q16 Quant

A.  

B.  

C.  

D.  

✓

Q17 Quant

A.  0.8

B.  0.7

C.  0.6

D.  0.9
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✓

Q18 Quant
What is the volume of a cube whose diagonal measures  cm?

A.  25 cm3

B.  27 cm3

C.  125 cm3

D.  127 cm3

✓

Q19 Quant

A.  83.6%

B.  82.6%

C.  86.9%

D.  83.2%

✓

Q20 Quant

.

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
According to Odisha Economic Survey 2024-25, an FDI Park was
created in which capital region?

A.  Bhubaneswar

B.  Berhampur

C.  Cuttack

D.  Sambalpur

✓

Q22 GA
Rourkela Steel Plant began production when its first blast furnace
“Parvati” was blown in. In which year did this occur?

A.  1955

B.  1957

C.  1959

D.  1962

✓

Q23 GA
Which among the following plateaus is often referred to as the “Roof
of the World” due to its extremely high average elevation?

A.  Deccan Plateau

B.  Tibetan Plateau

C.  Iranian Plateau

D.  Brazilian Plateau

✓

Q24 GA
In March 2026, the 57th Raising Day of the Central Industrial
Security Force (CISF) was held at which place in Odisha?

A.  Bhubaneswar

B.  Paradip

C.  Mundali

D.  Rourkela

✓

Q25 GA
Which Odisha government scheme, approved in April 2026 with an
outlay of ₹589 crore, aims to modernise the handloom sector and
support weavers across the state?

A.  Subhadra Yojana

B.  Mukhyamantri Hastatanta Bikasha Yojana

C.  KALIA Yojana

D.  Ama Shasan Initiative

✓

Q26 GA
Which organisation released its World Economic Outlook on 14
October 2025?

A.  World Bank

B.  International Monetary Fund

C.  Organisation for Economic Co‑operation and Development

D.  United Nations Development Programme

✓

Q27 GA
Which of the following acts was passed in 2025 in India to establish
the responsibilities, liabilities, rights, and immunities in case of
goods carried from port?

A.  Maritime Logistics Act, 2025

B.  Ocean Transport Modernisation Act, 2025

C.  Carriage of Goods by Sea Act, 2025

D.  Blue Economy Act, 2025

✓

Q28 GA
In November 2025, in the ICC Women’s Cricket World Cup,
Harmanpreet Kaur achieved which historic milestone?

A.  First Indian to score 1 000 World Cup runs

B.  Led India to their first Women’s World Cup title

C.  Highest individual score in a final

D.  Most sixes in a single tournament

✓

Q29 GA
India commemorates its victory in the 1971 Indo-Pakistan War on
which date, observed annually as Vijay Diwas?

A.  15 August

B.  26 January

C.  16 December

D.  30 January

✓

Q30 GA
What are the main types of rocks composing the Peninsular plateau?

A.  Old Crystalline, igneous and metamorphic rocks

B.  Igneous and metamorphic rocks with alluvial deposits

C.  Sedimentary and metamorphic rocks

D.  Volcanic ash and loess deposits of recent origin
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Q31 GA
Which of the following phrases marks the opening words of the
Preamble to the Constitution of India?

A.  We, the Sovereign People of India

B.  We, the People of India

C.  We, the Democratic Republic of India

D.  We, the Citizens of the Republic of India

✓

Q32 GA
Which of the following correctly matches the international
environmental agreement with its primary objective?

A.  Convention on Biological Diversity - Control of nuclear
weapons

B.  Montreal Protocol - Protection of ozone layer

C.  Paris Agreement - Elimination of plastic waste only

D.  Kyoto Protocol - Protection of biodiversity

✓

Q33 GA
Which Mughal monument, built during the reign of Shah Jahan, is
known for its extensive use of white marble with semi-precious
stone inlay?

A.  Gol Gumbaz

B.  Taj Mahal

C.  Charminar

D.  Qutub Minar

✓

Q34 GA
Which of the following correctly matches Personality with dance
form?

A.  Kelucharan Mohapatra – Kathak

B.  Rukmini Devi Arundale – Bharatanatyam

C.  Birju Maharaj – Odissi

D.  Guru Bipin Singh – Kathakali

✓

Q35 GA
Which organization is responsible for publishing the Human
Development Index (HDI)?

A.  International Monetary Fund

B.  United Nations Development Programme

C.  World Health Organization

D.  Reserve Bank of India

✓

Q36 GA
Why are controlled multiple reflections of sound, produced by
curved ceilings and suitable reflecting surfaces, used in a large hall?

A.  Reduce the speed of sound

B.  Distribute sound evenly throughout the hall

C.  Change the pitch of sound

D.  Absorb sound completely

✓

Q37 GA
Why do coastal regions of India experience an equable climate,
while northern parts of the country face extreme climatic
conditions?

A.  Because of their proximity to the sea

B.  Because they are located far from the Himalayas

C.  Because they are situated at higher altitudes

D.  Because they lie near the equator

✓

Q38 GA
What is the atomic mass unit (amu) based on?

A.  One atom of hydrogen

B.  One-twelfth the mass of a carbon-12 atom

C.  One atom of oxygen

D.  One electron of a helium atom

✓

Q39 GA
How many resolutions of the First National Congress Session in 1885
marked the beginning of the formulation of India's demands?

A.  Five

B.  Seven

C.  Nine

D.  Twelve

✓

Q40 GA
Which of the following chemicals were found responsible for the
sharp decrease in the amount of ozone in the atmosphere during
1980's?

A.  Chlorofluorocarbons

B.  Carbondioxide

C.  Sulphurdioxide

D.  Pesticides
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English

✓

Q41 English
Choose the correct option to fill in the blanks.

I bought ______ ice-cream cone and ______ pack of chips for my son.

A.  an, a

B.  a, a

C.  an, no article required

D.  no article required, a

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

They love to entertain everybody with their grandmother’s stories.

A.  regale

B.  bore

C.  disturb

D.  tire

✓

Q43 English
Select the most appropriate option to fill in the blank.

The scientist proposed a ______ theory that challenged long-standing beliefs in the field.

A.  conventional

B.  ordinary

C.  revolutionary

D.  submissive

✓

Q44 English
Select the most appropriate ANTONYM of the highlighted word to fill in the blank.

Her meticulous planning ensured success, while his approach was entirely ______.

A.  haphazard

B.  precise

C.  strategic

D.  thoughtful
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Q45 English
Identify the error in the following sentence and select the option that rectifies it.

As soon as she reached station, the train arrives.

A.  As soon as she reach the station, the train arrived.

B.  As soon as she reached the station, the train arrived.

C.  As soon as she reaches the station and the train arrived.

D.  As soon as she reached the station and then the train arrives.

✓

Q46 English
Select the option that can be used as a one-word substitute for the given group of words.

A person who travels from place to place

A.  Visitor

B.  Recluse

C.  Hermit

D.  Nomad

✓

Q47 English
Identify the antonym of the highlighted word in the sentence.
The crowd erupted in outburst after the team’s victory.

A.  venomous

B.  dubious

C.  turmoil

D.  peace

✓

Q48 English
Choose the option that correctly replaces the underlined proverb in the sentence below.

When his joke offended people, he learned that many a true word is spoken in jest.

A.  jokes can sometimes reveal real opinions

B.  humour should never be used seriously

C.  lies are often hidden in jokes

D.  everyone enjoys sarcasm

✓

Q49 English
Select the correct past tense form of the given sentence from the following options.
She reads her favorite mystery novels every evening while sipping warm tea by candlelight.

A.  She read her favorite mystery novels every evening while sipping warm tea by candlelight.

B.  She will read her favorite mystery novels every evening while sipping warm tea by candlelight.

C.  She has read her favorite mystery novels every evening while sipping warm tea by candlelight.

D.  She can read her favorite mystery novels every evening while sipping warm tea by candlelight.
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✓

Q50 English
In the given question, a statement is divided into four smaller segments labeled A, B, C, and D. The first segment is fixed. Rearrange the
remaining segments to form a coherent and meaningful sentence.

1 – The Egyptian pyramids
A – remain a mystery in construction
B – built over 4,000 years ago as tombs for pharaohs
C – including the Great Pyramid of Giza, originally 147 meters tall
D – with more than 100 still standing today

A.  1 – D – B – A – C

B.  1 – B – A – D – C

C.  1 – A – B – D – C

D.  1 – B – D – C – A

✓

Q51 English
Choose the correct Active Voice form of the given sentence.

The players were instructed to warm up properly, follow the coach’s directions closely, and avoid unnecessary injuries during practice by the
trainer.

A.  The trainer instructed the players to warm up properly, follow the coach’s directions closely, and avoid unnecessary injuries during
practice.

B.  The trainer has instructed the players to warm up properly, follow the coach’s directions closely, and avoid unnecessary injuries during
practice.

C.  The trainer is instructing the players to warm up properly, follow the coach’s directions closely, and avoid unnecessary injuries during
practice.

D.  The trainer had instructed the players to warm up properly, follow the coach’s directions closely, and avoid unnecessary injuries during
practice.

✓

Q52 English
A part of the given sentence has been underlined. Replace it with the most appropriate idiom from the given options.

Seeing the crowded examination hall, she became very anxious and nervous before the paper began, unable to stay calm.

A.  was in a lather

B.  was in cold blood

C.  was at her wits’ end

D.  was in high spirits

✓

Q53 English
Choose the correct option to complete the sentence.

Direct Speech: "I will finish the project by next week," she said.

Indirect speech: She said that she ____ finish the project by the following week.

A.  would

B.  should

C.  could

D.  must
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✓

Q54 English

Read the passage and answer the questions that follow.

Innovation has become a driving force behind economic growth and technological advancement. Industries continuously develop new products,
systems, and processes to improve efficiency and meet growing demands. However, this rapid pace of innovation often comes at a significant
environmental cost. Increased production, resource extraction, and energy consumption contribute to pollution, habitat destruction, and climate
change. Balancing innovation with environmental sustainability presents a complex challenge. While technological progress can offer solutions
such as renewable energy and eco-friendly materials, it can also intensify environmental degradation if not managed responsibly. Companies
and governments must therefore adopt sustainable practices, integrating environmental considerations into the design and implementation of
innovations. Furthermore, consumers play a vital role by supporting environmentally responsible products and practices. Achieving a balance
requires collective effort, long-term planning, and ethical decision-making. Only through a conscious and coordinated approach can societies
ensure that progress does not come at the expense of the planet’s well-being.

Identify a suitable title for the passage.

A.  The Conflict Between Technological Growth and Environmental Protection

B.  The Role of Governments in Promoting Industrial Development

C.  The Importance of Consumer Behaviour in Market Systems

D.  The Evolution of Technology in Modern Industrial Societies

✓

Q55 English
Identify the facts given in the passage.

A.  Innovation always leads to complete environmental protection

B.  Sustainability has no connection with technological progress

C.  Consumers have no influence on environmental outcomes

D.  Innovation can contribute to pollution and environmental damage

✓

Q56 English
Identify the tone of the passage.

A.  Celebratory and optimistic about unrestricted innovation

B.  Detached and indifferent towards environmental concerns

C.  Thoughtful and cautious regarding progress and its consequences

D.  Playful and humorous in discussing serious global issues

✓

Q57 English
Identify the structure of the passage.

A.  Issue introduced followed by challenges and proposed solutions

B.  Chronological history of technological inventions over time

C.  Narrative story focusing on environmental experiences

D.  Debate presenting opposing viewpoints without resolution
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✓

Q58 English
Select the correct summary for the passage.

A.  Innovation should continue without considering environmental impact

B.  Balancing innovation and sustainability requires responsible action

C.  Environmental protection is more important than technological growth

D.  Consumers alone are responsible for environmental conservation

✓

Q59 English
Parts of a sentence are given below. While the first and the last part (S1) and (S6) are in correct order, the parts in between are jumbled up.
Arrange the parts in the correct order to form a meaningful sentence.
S1. He mentioned that
P. project before the semester
Q. if students completed the
R. extra credit for
S. ended, they would receive
S6. their outstanding work.

A.  RSQP

B.  PQRS

C.  SPRQ

D.  QPSR

✓

Q60 English
Complete the sentence with a contextually and grammatically appropriate preposition.

She was waiting ___ the bus stop when it started to rain.3932

A.  at

B.  in

C.  on

D.  by
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସୂ ର୍ଯ୍ୟ  ଏକ ତାରା ଅଟେ, ଗ୍ର ହ ନୁ ହେଁ  ।

A.  The Sun is a star, not a planet.

B.  The Sun is a planet like Earth.

C.  The Sun is a moon of Jupiter.

D.  The Sun is a galaxy.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସମୁ ଦ୍ର  ପତନର ବୃ ଦ୍ଧି  ଏକ ଗମ୍ଭୀର ସମସ୍ୟା ଅଟେ ।

A.  Rising sea level is a serious problem.

B.  The sea levels are raise problem serious.

C.  Sea level rise be problems serious.

D.  Rising sea levels is an problems.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ପାଇଲଟ ଉଡ଼ାଜାହାଜକୁ  ସାବଧାନରେ ଏହାର ଉତଥାନ, ଉଡାଣ ଏବଂ ଅବତରଣ ପ୍ର କ୍ରି  ୟା ସମୟରେ ନି ୟନ୍ତ୍ରଣ କରନ୍ତି  ।

A.  The pilot carefully controls the aircraft during takeoff, flight, and landing operations.

B.  The pilot carefully control the aircraft during takeoff, flight, and landing operations.

C.  The pilot carefully controls aircraft during takeoff, flight, and landing operations.

D.  The pilot careful controls the aircraft during takeoff, flight, and landing operations.

✓

Q64 Odia
ଛାତ୍ର ମାନେ ଶି କ୍ଷକଙ୍କ କଥା ______ ଶୁ ଣି ଲେ।

A.  ଧ୍ୟାନ ଦେଇ

B.  ଧ୍ୟାନ ଦେଲେ

C.  ଧ୍ୟାନ ଦେବେ

D.  ଉପସ୍ଥି ତ ରହି ଲେ
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✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

ଭାରତରେ ଓଡ଼ି ଶା ହେଉଛି  ଲୁ ହାପଥରର ପ୍ର ମୁ ଖ ଉତ୍ପାଦନକାରୀ ଏବଂ ଦେଶର ଇସ୍ପାତ ଏବଂ ଖଣି ଜ ଅର୍ଥ ନୀତି ରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରେ। ପ୍ର ଚୁ ର ଖଣି ଜ ସମ୍ପଦ ର ଭଣ୍ଡାର ସହି ତ ଏହି
ରାଜ୍ୟ ପ୍ର ତି ବର୍ଷ  ଭାରତର ମୋଟ ଲୁ ହାପଥର ଉତ୍ପାଦନର ଏକ ପ୍ର ମୁ ଖ ଅଂଶ ଅବଦାନ କରି ଥାଏ । ଓଡ଼ି ଶାର ପ୍ର ମୁ ଖ ଲୁ ହାପଥର ସମୃ ଦ୍ଧ ଜି ଲ୍ଲାଗୁ ଡ଼ି କ ହେଉଛି  କେଉଁ ଝର, ସୁ ନ୍ଦରଗଡ଼ ଏବଂ ମୟୂ ରଭଞ୍ଜ,
ଯାହା ମି ଳି ତ ଭାବରେ ଏସି ଆର ସବୁ ଠାରୁ  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଖଣି  କ୍ଷେତ୍ର  ମଧ୍ୟରୁ  ଗୋଟି ଏ ଗଠନ କରେ। କେଉଁ ଝର ଜି ଲ୍ଲାର ଯୋଡା-ବାର୍ବିଲ ଅଞ୍ଚଳ, ସୁ ନ୍ଦରଗଡ଼ର କୋଇରା କ୍ଷେତ୍ର  ସହି ତ, ଉଚ୍ଚମାନର
ହେମାଟାଇଟ୍  ଗଚ୍ଛି ତ ପାଇଁ  ବି ଶେଷ ଭାବରେ ପ୍ର ସି ଦ୍ଧ। ଯୋଡା ପୂ ର୍ବ , କଟାମାଟି , ବନସାପାଣି , ଠାକୁ ରାଣୀ, ଦୈ ତାରୀ, ବୋଲାନି  ଏବଂ କୋଇରା ଖଣି  ପରି  ପ୍ର ମୁ ଖ ଖଣି  ଦେଶ ସାରା ବି ଭି ନ୍ନ ଇସ୍ପାତ
କାରଖାନାକୁ  ଲୁ ହାପଥର ଯୋଗାଣ କରେ। ଓଡ଼ି ଶା ଖଣି  ନି ଗମ (OMC) ପରି  ସରକାରୀ କ୍ଷେତ୍ର ର ଉପକ୍ର ମ ଏବଂ ଟାଟା ଷ୍ଟି ଲ୍ , JSW ଷ୍ଟି ଲ୍ , ରୁ ଙ୍ଗଟା ମାଇନ୍ସ , ସେରାଜୁ ଦ୍ଦି ନ୍  ଆଣ୍ଡ୍ କୋ. ଏବଂ
ଆର୍ସେ ଲରମି ତ୍ତଲ ନି ପନ୍  ଷ୍ଟି ଲ୍  ଭଳି  ଘରୋଇ କମ୍ପାନୀଗୁ ଡ଼ି କ ଏହି  ଅଞ୍ଚଳରେ ଖଣି  ଏବଂ ଖଣି  ପ୍ର କ୍ରି  ୟାକରଣରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶୀଦାର (ଖେଳାଳି  )।

ଓଡ଼ି ଶାର ଲୁ ହାପଥର ଭଣ୍ଡାର କଳି ଙ୍ଗନଗର, ଯାଜପୁ ର, ରାଉରକେଲା ଏବଂ ଅନୁ ଗୁ ଳ ଭଳି  ଶି ଳ୍ପ କେନ୍ଦ୍ରଗୁ ଡ଼ି କର ଅଭି ବୃ ଦ୍ଧି  ଲାଗି  ସହାୟକ ହୋଇଛି  , ଯାହା ରାଜ୍ୟର ଶି ଳ୍ପାୟନ ଏବଂ ନି ଯୁ କ୍ତି  ସୁ ଯୋଗକୁ
ବୃ ଦ୍ଧି  କରୁ ଛି । ଲୁ ହାପଥର ଏବଂ ପ୍ର କ୍ରି  ୟାକୃ ତ ଇସ୍ପାତ ଉତ୍ପାଦ ରପ୍ତାନି  ପାଇଁ  ରାଜ୍ୟ ପାରାଦୀପ ଭଳି  ପ୍ର ମୁ ଖ ବନ୍ଦର ସହି ତ ମଧ୍ୟ ସଂଯୁ କ୍ତ ଅଛି  । ତେବେ , ଖଣି  ଜନି ତ କାର୍ଯ୍ୟ କଳାପ ଯୋଗୁଁ  ପରି ବେଶଗତ
ଏବଂ ସାମାଜି କ ଚ୍ୟାଲେଞ୍ଜ ଗୁ ଡି କର ସମ୍ମୁଖୀନ ହେବାକୁ  ପଡି ଥାଏ। ଜଙ୍ଗଲ କ୍ଷୟ, ମୃ ତ୍ତି କା କ୍ଷୟ, ଧୂ ଳି  ପ୍ର ଦୂ ଷଣ ଏବଂ ସ୍ଥାନୀୟ ପରି ସଂସ୍ଥା ଉପରେ ପ୍ର ଭାବ ଭଳି  ସମସ୍ୟା ଚି ନ୍ତାର ବି ଷୟ ହୋଇପଡି ଛି ।
ଦାୟି ତ୍ୱପୂ ର୍ଣ୍ଣ  ଖଣି ଜ ଉତ୍ତୋଳନ ସୁ ନି ଶ୍ଚି ତ କରି ବା ପାଇଁ  ଓଡ଼ି ଶା କଠୋର ନି ୟାମକ ଢାଞ୍ଚା, ସ୍ଥାୟୀ ଖଣି  ଅଭ୍ୟାସ ଏବଂ ପୁ ନରୁ ଦ୍ଧାର ପଦକ୍ଷେପ କାର୍ଯ୍ୟ କାରୀ କରି ଛି । ନି ଯୁ କ୍ତି , କଲ୍ୟାଣକାରୀ ଯୋଜନା ଏବଂ
ଭି ତ୍ତି ଭୂ ମି  ବି କାଶ ମାଧ୍ୟମରେ ସ୍ଥାନୀୟ ସମ୍ପ୍ରଦାୟର ସଶକ୍ତି କରଣ ଖଣି  ନୀତି ର ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶ ହୋଇ ରହି ଛି । ମୋଟାମୋଟି  ଭାବେ କହି ବାକୁ  ଗଲେ , ଓଡ଼ି ଶାରେ ଲୁ ହାପଥର ଖଣି , ରାଜ୍ୟ
ଅର୍ଥ ନୀତି  ଏବଂ ଭାରତର ଇସ୍ପାତ କ୍ଷେତ୍ର ରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରୁ ଥି ବାବେଳେ ଜାରି ରହି ଥି ବା ସଂସ୍କାରଗୁ ଡ଼ି କ ବି କାଶକୁ  ସ୍ଥାୟୀତ୍ୱ ଏବଂ ପରି ବେଶ ସଂରକ୍ଷଣ ସହି ତ ସନ୍ତୁଳି ତ କରି ବା
ଲକ୍ଷ୍ୟ ରଖି ଛି ।

ଭାରତରେ କେଉଁ  ଖଣି ଜ ପଦାର୍ଥ ର ପ୍ର ମୁ ଖ ଉତ୍ପାଦନକାରୀ ହେଉଛି  ଓଡ଼ି ଶା?

A.  କୋଇଲା

B.  ଲୁ ହାପଥର

C.  ବକ୍ସାଇଟ୍

D.  ତମ୍ବା

✓

Q66 Odia
କେଉଁ ଟି  ଓଡ଼ି ଶାର ପ୍ର ମୁ ଖ ଲୁ ହାପଥର ଖଣି  କ୍ଷେତ୍ର  ମଧ୍ୟରେ ଅନ୍ତର୍ଭୁ କ୍ତ?

A.  କୋରାପୁ ଟ-ରାୟଗଡ଼ା

B.  ଯୋଡା-ବାର୍ବିଲ ଅଞ୍ଚଳ

C.  ପୁ ରୀ-କୋଣାର୍କ  ବେଲ୍ଟ

D.  ଭଦ୍ର କ- ବାଲେଶ୍ଵର

✓

Q67 Odia
କେଉଁ  ସରକାରୀ କ୍ଷେତ୍ର  ସଂଗଠନ ଓଡ଼ି ଶାର ଏକ ପ୍ର ମୁ ଖ ଖଣି  ଉତ୍ତୋଳନକାରୀ?

A.  ନାଲକୋ (NALCO)

B.  ଓଡ଼ି ଶା ଖଣି  ନି ଗମ

C.  ବାଲକୋ (BALCO)

D.  କୋଲ ଇଣ୍ଡି ଆ

✓

Q68 Odia
କେଉଁ  ବନ୍ଦର ଓଡ଼ି ଶାରୁ  ଲୁ ହାପଥର ରପ୍ତାନି  ପରି ଚାଳନା କରେ?

A.  ମାର୍ମା ଗାଓ

B.  ପାରାଦୀପ

C.  ବି ଶାଖାପାଟଣା

D.  କାଣ୍ଡଲା
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✓

Q69 Odia
କେଉଁ ଟି  ହେଉଛି  ଲୁ ହାପଥର ଖଣି  ସହି ତ ଜଡି ତ ପ୍ର ମୁ ଖ ପରି ବେଶଗତ ଚି ନ୍ତା ?

A.  ସାମୁ ଦ୍ରି  କ ପ୍ର ଦୂ ଷଣ

B.  ମରୁ ଭୂ ମି କରଣ

C.  ଜଙ୍ଗଲ ହ୍ରା ସ ଏବଂ ମୃ ତ୍ତି କା କ୍ଷୟ

D.  ହି ମବାହ ତରଳି ବା

✓

Q70 Odia
"ଆପଣା ହାତ ଜଗନ୍ନାଥ "-ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ନି ଜ ଉପରେ ଭରସା ନ କରି  ଜଗନ୍ନାଥଙ୍କୁ  ହାତ ଟେକି ଦେବା ।

B.  ନି ଜ ଉପରେ ଭରସା କରି  କାମ କରି ବା ।

C.  ନି ଜେ କାମ କରି ବାଠୁ  ଅନ୍ୟକୁ  କହି ବା ଭଲ ।

D.  ଜଗନ୍ନାଥ ନି ଜ ହାତରେ ଅଛନ୍ତି  ବୋଲି  ଭାବି ବା ।

✓

Q71 Odia
ସଂସ୍କୃତ ଶବ୍ଦ 'ହସ୍ତ'ରୁ  ସୃ ଷ୍ଟି  ହୋଇଥି ବା 'ହାତ' ଶବ୍ଦଟି  କି  ପ୍ର କାର ଶବ୍ଦ?

A.  ତତ୍ସମ

B.  ଦେଶଜ

C.  ତଦ୍ଭବ

D.  ବୈ ଦେଶି କ

✓

Q72 Odia
"ଛାତି କି  ପଥର କରି ବା"-ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ରାଗ କରି ବା

B.  ଧୈ ର୍ଯ୍ୟ  ଧରି ବା

C.  ଭୟଭୀତ ହେବା

D.  ଛାତି ରେ ପଥର ରଖି ବା

✓

Q73 Odia
ଆମେ ପୁ ରୀ ଯାଇ ଜଗନ୍ନାଥକୁ  ଦର୍ଶ ନ କଲୁ  ।- ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ପ୍ର କାର କ୍ରି  ୟାପଦ?

A.  ଅମି ଶ୍ର  କ୍ରି  ୟା

B.  ମି ଶ୍ର କ୍ରି  ୟା

C.  କେଉଁ ବି  ନୁ ହେଁ

D.  ଅସମାପି କା କ୍ରି  ୟା
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✓

Q74 Odia
ଗନ୍ଧି ଆ ଜି ନି ଷ ବ୍ୟବହାର କରି ବା ସ୍ୱାସ୍ଥ୍ୟ ପାଇଁ  ବି ପଦ ।- ଉକ୍ତ ବାକ୍ୟ ମଧ୍ୟରୁ  ଗୁ ଣବାଚକ ବି ଶେଷଣ ପଦଟି  ବାଛ ।

A.  ଗନ୍ଧି ଆ

B.  ଜି ନି ଷ

C.  ବ୍ୟବହାର

D.  ସ୍ୱାସ୍ଥ୍ୟ

✓

Q75 Odia
‘ନି ଷ୍ପାପ’ ଶବ୍ଦର ବି ପରୀତ ଶବ୍ଦଟି  ଲେଖ ।

A.  ପାପୀ

B.  ଅପାପୀ

C.  ପାପି

D.  ନି ଷ୍ପାପୀ

Computer

✓

Q76 Computer
What option should you use if you want to keep both the original
and edited versions of an MS-PowerPoint presentation?

A.  Save As

B.  Save

C.  Print

D.  Open

✓

Q77 Computer
Which of these is an audio file extension?

A.  .mp3

B.  .jpg

C.  .png

D.  .pdf

✓

Q78 Computer
In the latest MS Word version, which keyboard shortcut is used to
apply or remove bold formatting quickly?

A.  Ctrl + U

B.  Ctrl + Shift + B

C.  Ctrl + B

D.  Ctrl + I

✓

Q79 Computer
When starting a new presentation in Microsoft PowerPoint, which
option allows you to choose a built-in theme to quickly design
slides?

A.  File > Open

B.  File > New, then select a theme

C.  Home > Insert > Theme

D.  View > Themes > Apply

✓

Q80 Computer
What option in the Transitions tab lets you control how long a
transition lasts between slides?

A.  Rehearse Timings

B.  Duration

C.  Slide Advance

D.  Effect Options

✓

Q81 Computer
When you want to send a copy of a received email to other people,
which email option should you use?

A.  Reply

B.  Reply All

C.  Forward

D.  Compose
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✓

Q82 Computer
What does RAM stand for?

A.  Read Access Module

B.  Random Access Memory

C.  Remote Application Memory

D.  Rapid Access Machine

✓

Q83 Computer
Which of the following options correctly represents the main
purpose of System Software?

A.  To allow users to create and edit documents and
spreadsheets

B.  To manage and control the computer's hardware
components and resources

C.  To provide entertainment through video games and
streaming media

D.  To search for information and browse websites on the
internet

✓

Q84 Computer
What is the function of the Alt key?

A.  Modifier, altering the behaviour of the Shift Key

B.  Modifier, altering the behaviour of the subsequent key you
press

C.  Modifier key frequently used with Ctrl key

D.  Modifier key that alters the output of Window key

✓

Q85 Computer
What is the scope of a WAN?

A.  Single building

B.  Small office

C.  Large geographical area

D.  Single computer

✓

Q86 Computer
How do you align text to the left in MS Word 2010?

A.  Use the Center button in the Home tab.

B.  Use the Align Right button in the Home tab.

C.  Use the Align Left button in the Home tab.

D.  Press Ctrl + R.

✓

Q87 Computer
How do you create a series with a custom increment (e.g., 2, 4, 6) in
Excel?

A.  Enter the first two numbers, select them, and then drag the
fill handle

B.  Type a formula to specify the increment

C.  Right-click the cell and select Custom Series

D.  Use the Insert tab to define a custom increment

✓

Q88 Computer
In MS-Word 2010, after copying or cutting text, which command is
used to insert it in a new location?

A.  Save

B.  Delete

C.  Paste

D.  Enter

✓

Q89 Computer
What does sorting 'Z to A' mean when applied to a text column?

A.  Sorts text in reverse alphabetical order

B.  Sorts text in random order

C.  Sorts text by colour

D.  Sorts text by length

✓

Q90 Computer
Which of the following Order Values is used for text values in an MS
Excel worksheet?

A.  Smallest to Largest

B.  A to Z

C.  Newest to Oldest

D.  Cell Color
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Reasoning

✓

Q91 Reasoning
Six boys—Pawan, Kabir, Rahul, Sunil, Tej, and Vimal—are sitting
around a circular table, facing the centre of the table. Tej is third to
the right of Kabir. Sunil is the immediate neighbour of Tej. Pawan is
to the immediate left of Vimal. Rahul is fourth to the right of Pawan.
Who is second to the right of Vimal? 2122

A.  Rahul

B.  Pawan

C.  Sunil

D.  Kabir

✓

Q92 Reasoning
G is the mother of T’s wife. L is the daughter of P who is the only
daughter of M and G. How is T related to M? 2598

A.  Son

B.  Brother

C.  Daughter's husband

D.  Son’s son

✓

Q93 Reasoning
A, B, C, M, N and O live on six different floors of the same building.
The lowermost floor in the building is numbered 1, the floor above
it, number 2 and so on, till the topmost floor is numbered 6. B lives
on an even numbered floor but not on floor number 4. Only two
people live between B and A. C lives on an odd numbered floor but
not on the lowermost floor. Only two people live between C and N.
M lives immediately below C. Who lives immediately above O?

A.  A

B.  C

C.  M

D.  N

✓

Q94 Reasoning
In a certain code language, ‘EVIL’ is coded as ‘7159’ and ‘VAIL’ is
coded as ‘1587’. What is the code for ‘A’ in the given code language?

A.  8

B.  9

C.  7

D.  1

✓

Q95 Reasoning
Select the triad which follows the same pattern as that followed by
the two triads given below. Both triads follow the same pattern.

KC-HA-FI
TL-QJ-OR

A.  VN-SL-QT

B.  VN-SL-QU

C.  VM-SL-QU

D.  VM-SK-QU

✓

Q96 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

TPX32 SOW41 RNV50 QMU59 ?

A.  PLT68

B.  PLT69

C.  PLU68

D.  PLU69

✓

Q97 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and
‘-‘ are interchanged and ‘x’ and ‘÷’ are interchanged?
51 ÷ 4 + 18 x 3 - 9 = ?

A.  201

B.  207

C.  216

D.  239

✓

Q98 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts,
decide which of the given conclusions logically follow(s) from the
statement(s).
Statements: All toes are fingers. All fingers are thumbs.
Conclusion (I): All thumbs are toes.
Conclusion (II): All toes are thumbs.6103

A.  Only Conclusion (I) follows

B.  Only Conclusion (II) follows

C.  Both the Conclusions (I) and (II) follow

D.  Neither Conclusion (I) nor Conclusion (II) follows
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Q99 Reasoning
Based on the English alphabetical order, three of the following four
are alike in a certain way and thus form a group. Which is the one
that does not belong to that group?
(Note: The odd man out is not based on the number of
consonants/vowels or their position in the letter cluster)2832

A.  BGH

B.  IMO

C.  WAC

D.  GKM

✓

Q100 Reasoning
Each vowel in the word EPICURE is changed to the letter
immediately following it in the English alphabetical order, and each
consonant is changed to the letter immediately preceding it in the
English alphabetical order. How many letters will appear exactly
twice in the group of letters thus formed? 750

A.  0

B.  1

C.  2

D.  3
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